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How to Convert
To Load (Open) an image:

Double-Click on its filename.    The image viewing area is at the upper left, with the name of 
the image, and the Conversion area at the upper right. 

Buttons:
·    Zoom, always present, to see a blowup of the current image.
·    Edit, each time you Load an ICO image (see ICO to BMP)
·    16 col, each time you Load a 256-color BMP image (see BMP to ICO)
·    Sav, if the current image can be Saved back (see Image Menu).

Before you Convert:
·    BMP to ICO:    You may select a Transparent Color for the icon.
·      ICO to BMP:    If the Icon has a Transparent Color, which will become the Background 

Color for the bitmap, you may change it.

To Convert:
To Convert the current Image to the other format, Click on the Convert > button or press Alt-
C. The new file will be saved in the current SAVE directory, usually the same one as the 
OPEN (see Browse Directories).    

Suggested Target File Name:
This name, at the right of the image name, will be the same as that of the image, the 
target .ICO or .BMP extension being added automatically.    For example, the BMP version of
ICOTEST.ICO will be saved as ICOTEST.BMP.    

Some Target and Image names will be slightly different from the original file name, to 
indicate their status and to avoid overwriting valid pictures:

Original filename (truncated if longer than six characters), plus:
_C:    bitmap image Cropped from a BMP (Image name: [Crop'd])
_E:    icon image that has been Touched Up (Image name: [Edited])
_X:    icon image extracted from a mutl-format Icon or from an EXE or DLL file which 

contains only one icon (Image name: same)
Original filename (truncated if longer than four characters), plus:
_nnn:    icon image from a multi-icons EXE or DLL file (Image name: same; nnn: position of 

the icon in the file).
[Grab'd]: this image, taken from a Screen Grab, has no name yet...

To Change the Target File Name, Click on the text box which contains it, or press Alt-N. 
Make any change, then press <Enter> (or click anything outside the text box) to accept the 
change, or <Esc> to cancel it.

When the Conversion is done:
Both the ICO and BMP file names are highlighted in the file lists. If you have selected the 
AutoLoad Conversion Result Option , the new image is loaded into BMPTOICO. Otherwise, 
the Current image is unloaded, and the top portion of the form is reset to its starting state.



BMP to ICO

BMP Formats:
Only valid Windows BMPs can be loaded directly into BMPTOICO. If the BMP is larger than 
icon size, a new form will appear, with the BMP loaded full size. You can then Crop an Icon 
size picture out or it, or Shrink it, or part of it, to Icon size.

Some BMP bitmaps cannot be loaded into BMPTOICO because they are not accepted by 
Visual Basic 3.0, sorry.    That is the case if a bitmap...

... has more than 256 colors

... is bigger than 1MB

... is 16- or 32-bit

... is in the OS/2 format.

256-color bitmaps:    A red "256" will show at the right of the Image Name if a BMP has 256 
colors. Saving a Crop from such a bitmap will preserve all its colors.    If your video mode is 
set to 16 colors, you will not see the colors properly, and Saving a Crop will use 16 colors 
only.

Converting to ICO:
Saving Format:    Windows 3.x      (32 x 32 x 16 colors)
Before Converting, you may select a Transparent Color for the Icon: BMPTOICO will 
suggest one, but you may change it.

The 16 col button:
Most of the colors in these bitmaps will not Convert well to the standard palette of 16 colors 
that Windows 3.x uses to Save ICO files.    The 16 col button, which appears each time you 
Load a 256-color BMP, will help you by decreasing the colors to the 16 standard ones, and 
only those, before you perform the conversion to ICO.    Depending on how far off your 
colors are from Windows' standard 16 color palette, the result can be very deceiving. On the
other hand, if the colors in the BMP are all part of the Standard 16 palette, you will see no 
change when you click this button. 



Transparent Color for the Icon
What it is...

With Windows icons, you may select a color to be transparent so that the Wallpaper will 
show through the icon's surroundings when the program is minimized in Windows 3.1 (see 
image below, Result); in Windows 95, the Transparency will work when you use the Icon to 
create a ShortCut to its application.

When you load a bitmap into BMPTOICO, it will try to set a    Default Tranparent Color, 
usually the color found most often in the four corners of the image, or grey if this color is not 
part of Windows' standard palette of 16 solids (or if it is Black, which can never be used as a
Transparent color).

To Change it:
Click on a color in the palette at the upper right.    If you don't want any color in your Icon to 
become Transparent, select a color which is not present in your bitmap.

All the pixels that are of the selected color will be made transparent, so be careful if you click
on a color which is already present in the image (BMPTOICO can check for you, if you 
select that Option).    You can Touch Up the resulting Icon later to make those pixels as 
Foreground color again.    Another solution to this problem is to edit the BMP file before 
loading it into BMPTOICO, coloring the area you wish to be transparent with a color that you
don't use anywhere else:



Crop a BMP to Icon Size

If the BMP you wish to Load, or your Grab from Screen, is larger than Icon size, the    Crop 
form will automatically open, with the full BMP or Screen Grab in a View window at left, an Icon,
a Zoom button,    four arrow buttons and a SHRINK button.    If the image is larger than the View
window, there will be a vertical and/or an horizontal scroll.

If the image does not load properly into the Crop form the first time (palette problem: this may 
happen with fancy 256 color images), Click the Cancel button and try again.

NOTE (True or High Colors video modes):
Even if the little icon seems OK, it might be converted to an all-Black picture when you Load it 
to BMPTOICO's main form, because the icon's colors wil be decreased to 256 during the 
operation.    BMPTOICO will warn you each time.

Crop to Icon Size:

The Icon Cursor, a transparent rectangle with a black border, is positioned at the top left.    Its 
content shows in the small Icon at the right.

To move the Cursor pixel by pixel, Click on the Arrow buttons or Press the Arrow keys (a bit 
faster due to key Autorepeat). To move even faster, for distances further than the cursor's 
dimensions, Click the Cursor near its center, then Drag and Drop it where you want it. The 
Cursor always stays inside the view window:    use the Vertical and/or Horizontal scrolls to reach
other areas of the BMP.

The Icon image is updated automatically as you move the Cursor:

The SHRINK function:
You can, at any time, Shrink an area or the whole image to Icon Size.    Click the SHRINK 
button to open that function.



Other available functions: 
Buttons:

Zoom:    see a blowup of the Icon (you can also press Alt-Z).    If the image you are 
Cropping from is a fancy 256-color image, its palette might be disturbed when you return 
from the Zoom function.
Cancel: Cancel the Crop operation ( you can also press the <Esc> key).

File Menu:
Info:    Information about the big image.
Full View of the big image (disabled if the whole image fits into the View Window).

When you are happy with the Icon...
Click on the Load button. The small image will show in BMPtoICO's main form upon exit, 
ready to be Converted into an Icon.

Back in BMPTOICO's main form:
To remind you that the image is Cropped, the suggested ICO name will end with "_C", and 
the image name will change to [Crop'd].BMP.    If you Cropped from a Screen Grab, it will be 
named [Grab'd].BMP and the suggested ICO name will be empty. You may, at this point, 
Save the resulting image as a small BMP (see Image Menu).

If the original BMP has 256 colors, you can leave it as it is, or use the 16 col button to 
reduce its colors to 16 before Saving or Converting it to ICO.    Try both ways, as many 
colors don't convert well to 16 colors icons; it is a good idea to Save the Cropped or Shrunk 
image as BMP first, so you don't have to redo all the work!



Shrink the Crop...

If your image is small enough, you might want to Reduce it all to make your Icon. Or, you might 
want to use only an area of the image, but it is still bigger than Icon Size:    Click the SHRINK 
button in the Crop form, which will widen to show the Shrink controls.    Play with them, and 
watch the results in the Cropped Icon... The Resize Step scroll changes the resizing step of the 
cursor: start with    a high value, then switch to a lower one (miimum is 4 pixels) to refine your 
Shrink.    If your image is 256 colors and those colors are too far off the Windows standard 
palette, you will get mostly black pixels when you Shrink.

NOTE (True or High Colors video modes):
Even if the little icon seems OK, it will probably be converted to an all-Black picture when 
you Load it to BMPTOICO's main form, because the icon's colors wil be decreased to 256 
during the operation.    BMPTOICO will warn you each time.

Shrink an area:    
Click the << or the >> buttons to reduce or enlarge the Cursor. The area under it will be 
Shrunk to 32 x 32 pixels (or enlarged, if its dimensions are smaller than Icon Size: the 
Cursor dimensions are always displayed).
The Resize Step, in multiple of four increments, can be changed with the Scroll.    The 
smaller size the Cursor can be is Step x Step pixels (as small as 4 x 4), and it can never be 
larger than the View Window.
The Arrow buttons, Drag and Drop of the Cursor and the Scrolls remain active, as well as 
the Cancel and Load buttons.

Shrink All: 
Click the Shrink All button to automatically reduce the whole image to 32 x 32 pixels.    If the
original image is not a perfect square, there might be grey borders on two of the sides, 
which will be part of the Shrunk bitmap. If this is the case, the Color Palette will appear 
above the Shrink function: if you wish, Select    a more suitable Color for the borders. 



If the image you are Cropping from is a fancy 256-color image, its palette might be disturbed
when you Shrink All, but should be reset properly when you Exit the Shrink function.    If you 
don't like the result, Click the same button, now renamed Reset Shrink, to come back to the
previous Shrink Area state.

If you like the Shrink result...
Click the Load button to send it back to BMPTOICO. If you don't, Click the No Shrink button
to reset the Cropped Icon to Actual Icon Size.    



ICO to BMP

ICO Formats:
Only valid Windows 3.x Icons, and some Windows 95 Icons,  can be Loaded into 
BMPTOICO.    You can also Extract Icons from EXE or DLL (and ICL) files (see File Lists), 
and Save the extracted Icon as a real Win 3.x ICO file (see Image Menu for Help on Save).

Windows 3.x Icons: 
They always measure exactly 32 x 32 pixels and can have only the Windows Standard 16 
colors; they show as a rectangle because pixels are not square.

Windows 95 Icons: 
They can have up to six formats, and 256 colors, or can be 16-color bitmaps. BMPTOICO 
can work with a Win 95 ICO file if...
·    it has more than one format:    BMPTOICO will only Load the 32 x 32 format, if it is not 

empty.    You can, if you wish, Save the 3.x format icon to a separate ICO file;
·    it has 256 colors:    it really has only 20, and BMPTOICO will Load it correctly if your 

video mode can show 256 colors. You can Touch it up, using all colors,    but BMPTOICO
can only re-Save it to a16-color ICO file, so be careful; Converting it to BMP, however, 
will preserve all its colors.    A red "256" will show at the right of the Image Name if the 
Icon has 256 colors;

·    it is really a 16-color bitmap:    BMPTOICO will Load it, but only allow you to Save it with 
a BMP extension (you be Convert it back later to a real Windows 3.x Icon).

OS/2 Icons:    
They cannot be Loaded into BMPTOICO.

Converting to BMP: 
Saving Format:    Windows, RGB, uncompressed, 16 or 256 colors.
Bitmaps are saved with a color definition for each pixel: all colors become foreground. If the 
Icon you are converting has a Transparent Background, you may change it before 
converting. If your Icon has more than 16 colors, the BMP will be saved with 256 colors.

The Edit button:
Clicking this button will open BMPTOICO'S Icon Touch Up Editor.
 



Background Color for the Bitmap
What it is...

If the loaded Icon has a Transparent Background, you will be able to see BMPTOICO's grey 
background through it.    When you save it as a BMP, this grey background will be saved as 
the grey color, not as Transparent, a concept that bitmaps ignore.

To Change it:
If you want a Background of a different color for your BMP, click a color in the palette at 
upper right to select it. If the icon does have a Transparent Color, you will see the change in 
the image.

No Transparent Background?
If you don't see a change when you click on a few of the colors, it is because your Icon does
not have any Transparent pixel: if you want a different color for the Background, you may 
Touch Up the Icon before Converting it to BMP.



Image Menu
Except for Grab from Screen (256 color mode or less) and Exit, all items in this menu are 
enabled only if an image is Loaded.    The whole menu is disabled when you are Changing the 
Directory.

Info
Dimensions, number of colors, format, etc., of the loaded image or of the file it was 
Extracted, Cropped or Shrunk from. Date, Size, etc. of the file.

Unload
Unloads the current image and resets the top portion in its starting state. If the current image
can be Saved, you will be asked if you want to do it before Unloading.

Edit Icon | Win 16 Colors
The menu item name changes if the loaded image is...
· ... an Icon: labeled Edit Icon, opens the Icon Touch Up Editor (same as the Edit button)
· ... a 256-color Bitmap: labeled Win 16 Colors, decreases the image's colors to Windows' 

standard palette; renamed Reset Colors to reverse the operation (same as the 16 col 
button; this item is disabled if the BMP has only 16 colors).

Save [ ] as...
This item is enabled only if the current image can be Saved; if it is, the Sav button will also 
appear at the right of the image. After the Save, the Image will be automatically re-loaded 
into BMPTOICO.

Images that may be Saved are:
·    [Crop'd] from a BMP, as a new bitmap; the suggested filename will end with "_C". 
·    [Edited] Icon, as a new Icon; the suggested filename will end with "_E"; you can of 

course Save it back under the original name.
·    [Extr'd] Icon from an EXE or DLL file, as a Windows 3.x icon; the suggested filename will

end with "_X".
·    [Win3.x] Icon from an Icon with that contains more than one format, as a Windows 3.x 

icon; the suggested filename will end with "_X".
·    [BMPicn] Icons that are 32 x 32 x 16 colors bitmaps with an ICO extension (Windows 95

can use them as Icons), as a 16-color bitmap; the suggested filename will be the same 
as the ICO file.

·    [Grab'd] from the Screen, as a new bitmap; the suggested filename will be empty.

Copy to ClipBoard
Send the current image to the ClipBoard.

Grab from Screen    (256 color mode or less only)
Opens the Screen Grabber with a snapshot bitmap of the current state of the screen (minus 
BMPTOICO, which will be automatically Minimized during the capture). If the current image 
can be Saved, you will be asked if you want to do it before Grabbing.    This item is available 
at any time.
 
When the Grabber is ready (wait for the upper left red label to show and the two quick 
beeps), use the Mouse to select a rough area around the image you wish to grab. You may 



change the Color palette from the 16 colors default, which is best to Grab Program Manager
Icons, to 256.    If the red label in in your way, Click the Down Arrow button at its upper right 
to send it to the bottom of the screen.

When you Click the OK button, or press Alt+O, your Selected Area is sent back to 
BMPTOICO; if it is larger than 32x32 pixels, which is very likely,    the Crop to Icon Size form 
will open automatically.
You can also Cancel the Grab by clicking the Cancel button or pressing Alt+C.

Because BMPTOICO cannot deal with bitmaps that have more than 256 colors, this menu 
item is not available if your video mode is set to True or High Colors.

Exit
Ends BMPtoICO.    You can also Click the Exit button.
If the current image can be Saved, you will be asked if you want to do it before. Cancelling 
the Save will also Cancel the Exit.



Options Menu
These are Toggle Options:    a check mark appears at their left if they are set. Your options are 
saved in the BMPTOICO.INI file when you Exit the program, and reset the next time you use it 
(the INI file is created in your Windows directory the first time you use BMPTOICO) .

AutoLoad Conversion Result
If you select this option, the resulting ICO (converted from BMP) or the resulting BMP 
(converted from ICO) will be loaded back automatically into BMPTOICO, and you can get 
Info on it from the Image Menu.    If the result is an Icon, follow the instructions on screen to 
Test it on your desktop (Testing is not available if you are running Windows 95, since it does 
not recognize changing a program's Icon after the program has started).    The default is 
AutoLoad On.

Background Warning for BMP>ICO
You will be warned if the Background Transparent Color your are selecting in the Color 
palette is used in your image. The default is to warn the user.

 Win95 Small Icon in Zoom
Windows 95 uses at least two icon sizes: Normal (32x32 pixels) or Small (16x16 pixels).    If 
the ICO file does not contain a separate 16x16 icon, Windows 95 will use the Normal icon, 
reduced to half size.    You can get an idea of what your Windows 3.x Icon will look like in 
such a situation by selecting this option: the small icon will be shown each time you Click a 
Zoom button in BMPTOICO. The default is not to show the Small Icon.

Unfortunately, if the ICO you have loaded into BMPTOICO does contains a 16x16 icon 
(check the Info for the file in the Image menu), you cannot see it, as BMPTOICO does not 
know how to load it yet... (it is still a Windows 3.1 program after all).



File Lists
There are two file lists in BMPTOICO; they are always on screen so you can monitor your 
session at all times; they show all files in your OPEN directory that have the extensions 
specified by the File type Option at the right.    

File Type Options:
·    Show all ICO and BMP files: they can be loaded directly if valid.
·    Show all EXE and DLL, ICL or NIL files: Icons can be extracted.
If the OPEN directory has only files of one type (ICO/BMP or EXE/DLL...), both Options will 
be disabled.

How to use the File Lists:
·      Click on a picture name to Highlight it (for the File button popup menu),

or
·      Double-Click on the name to Load the image into BMPTOICO. If the Image cannot be 

Loaded, the Icon will be a big X, and an explanation message will be displayed.    If an 
EXE or DLL file you try to Load from has no Icon, BMPTOICO will simply beep.

To Refresh a file list, click on it with the Right mouse button (useful if you have done some 
file management outside of BMPTOICO).



File Buttons
These buttons, which are at the lower right of BMPTOICO, work with the File Lists:

View All
View all ICOs and BMPs in the current working directory, then select an image to Load into 
BMPTOICO.    This button is disabled if your are working with EXE/DLL files, since its action 
is automatic for files that contain more than one Icon.
 

File
A PopUp menu that allows you to act on a file highlighted in a File List.    If you are working 
with EXE or DLL... files, this button is renamed "File Info", and it does not display a menu.

Browse Dir.
Change the current OPEN directory and, if it is on a read-only disk, the SAVE directory.



View All
When it opens...

When you Click on the View All button, or press Alt-V, you get another form which shows up
to twelve ICO images on the left. If there are no ICO files in the current directory, the form 
will show up to twelve BMP images.    The total number of ICO or BMP images in the 
directory is indicated in the form's title bar.    Each image has its file name, dimensions and 
color number under it. 

This form opens automatically if you double-click an EXE or DLL [ICL, NIL] file that contains 
more than one icon; the total number of icons in the file is indicated in the form's title bar, 
and BMPTOICO will create a name for each icon based on its position in the file (sorry, it 
cannot extract the icon names stored in ICL or NIL files).

Valid images:
Only Icons or Bitmaps that can be loaded into BMPTOICO can be Viewed (see valid formats
in BMP to ICO and    ICO to BMP). If a Bitmap is larger than icon size, it will be shown 
reduced to icon size, in its true proportions.    

Non-valid images are identified by a big X image, and some pertinent information will 
replace the dimensions on the second line.

Global functions:
· Display another group of twelve pictures:    Click on the << or >> button.
· Change the type of the pictures:    Click on the ICO or BMP Option at upper right; if there

are none of one type in the directory, the corresponding Option will be disabled (the 
Options don't show if you are viewing Icons from an EXE or DLL file).

· Cancel:    Click on the Cancel button or press Alt-C or the <Esc> key.

To Select an image...
Click on it or on its name: its text information will be colored white on blue.

Image functions:
· Load the selected image into BMPTOICO's main form: Click on the Load button or press

Alt-L; the button is disabled if the Selected image is not valid.
· Zoom /    Full View:  Click on the button marked Zoom or Full; its caption changes 

according to the actual size of the Selected Image, and it is disabled if the Image is not 
valid.

· File menu:  Its items are: Info, Delete and Rename (the last two are disabled if the 
OPEN directory is on a Write-Protected floppy or on a CD-ROM).



File
When you click this button, a PopUp menu appears. All Action items apply to the currently 
highlighted filename in one of the two File Lists.    If you don't select any item in the menu, Click
anywhere outside the menu to make it disappear.

Note: Delete, Rename and Copy are disabled if the OPEN directory is on a Write-Protected 
floppy or on a CD-ROM.

Delete
Delete the highlithed file; you will be asked to confirm. 

Rename
Rename the highlighted file.    You only need to enter the filename, the extension and path 
are automatically added by BMPtoICO.

Copy
Copy the highlighted file, with another name, to the Same directory.    Enter only the filename
(see Rename above).

Info
Get complete information about the file on the disk: Width, Height and number of Colors of 
graphic files; if it is a multi-format ICO file, get the total number of formats. If the file is OS/2, 
it will say so. If the file is EXE or DLL (ICL/NIL), get the total number of icons in the file. You 
also get the size in bytes of the file, and the last date and time it was last saved; if the file is 
Read-Only, the message will say so.

Move > New dir
Copy > New dir

Move or Copy the highlighted file to another directory, with the same file name; after the 
action is performed, you will be asked if you want to move to the new directory.



Browse Directories
When you Click the Browse Dir. button, a Directory list appears over the File Buttons, a Close 
Dir. button and a Drive list below it.

BMPTOICO can work in only one OPEN directory at a time, and you can only SAVE to the same
directory (unless your Open directory is read-only: see below). Your OPEN and SAVE 
directories are kept in the BMPTOICO.INI file, and will be used as defaults the next time you run
the program.

How it works:
· Select a valid Drive:    if it is read-only (Write-Protected floppy or CD-ROM), you will be 

asked to select a valid SAVE directory. In the case of a Write-Protected floppy, you can 
remove the Write Protection at this point and select your OPEN directory when you are 
asked for a valid directory.

· Select a valid Directory: the ICO/BMP and EXE/DLL Options are still visible and can be 
changed at this time.    If the directory can be written to, your SAVE directory will be 
identified as "[same]".

· Close: Click the Close Dir. button, or Load a file by Double-Clicking on its filename.    You 
cannot Close the Directory function if there are no files of the selected types (ICO/BMP or 
EXE/DLL...) in the selected directory.

Closing will Unload the currently loaded image if there is one.    If it can be Saved, you will be 
asked if you want to do it first (if you Cancel the Save, BMPTOICO will reset itself to your 
previous OPEN and SAVE directories).



Icon Touch Up Editor
What it does...

You can quickly Touch Up an existing Icon with a few Tools: Move, Draw, Fill, Line and 
Rectangles; you can also add Text to it.    If you prefer a full Icon Editor with all facilities, you 
are invited to try the full version, ICOEDIT.

To Open it...
Click the Edit button or press Alt-E , or select Edit Icon in the Image Menu (the button and 
menu item are not available if the loaded image is a BMP).
When the Editor opens, the enlarged Icon is magnified in the Editing area at the left, and 
displayed in actual size at the top right.    

Default Background (Transparent, or Screen, or Eraser) Color:
If your current video mode is... 
·    256 colors or more: a solid medium Grey
·    16 colors or less: same color as the Background Color currently selected in 

BMPTOICO's main form.
In both video modes:    If you Edit an Icon that already contains the Editor's default 
Background Color (medium grey can be used in 256 colors Icons),    you will be given the 
choice of another Background Color for the Editor when it opens.    Try to select one that is 
not present in the Icon (BMPTOICO checks for you), otherwise all Foreground pixels will be 
converted to Background ones as soon as you start using the Undo features.    The color you
select as Background will be disabled as Foreground anyway.



Screen Inverse:    some Icons have pixels that are Screen Inverse; the TouchUp Editor 
cannot draw them, and will offer to change them to pure Background before you Edit them.   
If you chose not to, they will show as pale green if your video mode is 256 colors.

Cursor Position:
You can always know where the cursor is and if a pixel is part of the Foreground or the 
Background as you move the mouse over the Editing Area.    In the rare case when your 
Icon contains Screen Inverse pixels that you chose not to change to Background, it will say 
"Sinv".

To Select a Tool:
The Tool palette consists of six Tool buttons. Click on a button or select the item in the Tools 
menu.

To Select an Option:
·    Foreground: Select the Foregr. option, or Click one of the Foreground Colors; you can 

then use the Color palette.
·    Background: Select the Bckgr. option, Click the Background colors, or Click on the 

Eraser; there is only one Color available for the Background, see above.
These options are disabled when you are using the Move Tool.

To Select a Color:
Click on a color in the Color palette with the Left or the Right mouse button; you can thus 
use two colors at at time.    The Editor's palette is the same as in BMPTOICO's main form, 
and contains Windows's standard palette of 16 solids.

256-color Icons:    If you Touch Up such an Icon and your system can show at least 256 
colors, the palette will have three more colors: very pale Cream, pale Blue and pale Green 
plus, if it is not used as the default Background Color (see above), medium Grey.

To Paint:
Painting is done in the Editing area at left; follow the simple instructions displayed at right.

To Erase:
There is no Eraser Tool in the Touch Up Editor, because Painting the Background will 
automatically erase any Foreground pixel: a small pencil eraser at the upper right of the BG 
option acts as a reminder.

To Undo:
There are three levels, all accessed via the Edit menu:
·    Undo / Redo Last:    reverses only the last operation.
·    Undo to Undo Icon:  undoes to the Icon at upper right; you can also Double-Click the 

Undo Icon itself.
·    Reload Original Icon: reloads the original Icon from BMPTOICO's main form.

When you are happy... or Not !
· Click the Load button to send the edited Icon back to BMPTOICO's main form (to be Saved 

as an ICO and/or Converted to BMP). To reflect the change, the Image Name will become 
[Edited].ICO, and the Target Name will end with _E.

· Or, Click the Cancel button to Cancel any editing and return to the original image in 
BMPTOICO.





    ICOEDIT
Also by MyCat Software, ICOEDIT is the full version of BMPTOICO's Touch Up Editor.    It has 
much more Tools and functions:

· Edit Icons or Bitmaps (Icon size or smaller) 
· Edit New Icons or New Bitmaps from scratch
· Resize Image (Icons: 16x16; Bitmaps: 16x16 to 32x32, even rectangular)
· Make Buttons automatically (Bitmaps only)
· More Tools: Circles, Eraser, Swap Colors
· Create your own colors for the Fill, Rectangle and Circle Tools
· More Edit functions for a Selected area:    Cut/Copy and Paste, Flip
· Flip, Rotate, Shift the whole Icon
· Use any Font when you Add Text
· Check an Icon's Transparency

Look for ICOEDIT.ZIP wherever you found BMPTOICO.



Editor: Tools
You can also select each Tool with the Tools menu.

Except for the Move Tool, which uses no Color and can be Undone only once (with no Redo 
possible), all Tools work with either the Foreground option (Color palette available) or the 
Background/Eraser one (default Color only); the last operation is reversible indefinitely (until 
you perform another operation) by Selecting Undo Last / Redo Last in the    Edit menu. or 
pressing Ctrl+Z.

    Move
Selects a rectangular region in the editing area, allowing you to Move it with its Transparent 
pixels (if any in the Selection) or Delete it.
Click in the editing area with a Mouse button to anchor one corner of the area you want to 
select, Drag the mouse until the flexible box that appears surrounds the area you want to 
select; Release the button.    If you make a mistake while selecting, click outside of the 
current selection and start over.
The area will remain selected after each move, ready to be moved again, until you Click 
outside it in the editing area or until you Click a button on the form: this will commit the 
Selection to the Icon.
 
To Delete the Selection:    Select Delete Selection in the Edit menu, or press the Del key.
To Move the Selection: Click inside its borders (where the Cursor changes to four white 

arrows), Drag the Selection where you want it, Release the button.
To Copy the Selection:    Hold down the CTRL key while you Click the Editing area to 

prepare for the Move. 

    Draw
Paints individual pixels.
Click in the editing area, Release the button. To paint more than one pixel, Drag the mouse 
slowly before releasing the button. Undo    Last is updated each time you click the Editing 
area.

    Fill
Fills a closed area..
Click in the area to be Filled: all adjacent pixels which are the same color as the starting 
pixel will be colored automatically.

    Line
Paints a one-pixel wide line.
Click in the Editing area to anchor one end of the line, Drag the mouse until it reaches the 
other end of the line you want to draw, Release the button.

    Rectangles
Paints a Hollow or Filled Rectangle.
Click in the Editing area to anchor one corner of the rectangle, Drag the mouse until it is the 
size and shape you want, Release the button.





Editor: Edit menu
Undo Last / Redo Last     (Ctrl+Z)

Reverses the Last operation, from the time you Clicked the Editing area.    It is a toggle 
function, that works both ways until you perform another operation.    This item is disabled if 
no reversing can be done.    If you are using the Move Tool, only one Undo Last is permitted,
and no Redo Last.

Delete Selection     (Del)
Deletes the currently selected area.    Enabled only if you are using the Move Tool and have 
selected an area.

Undo to Undo Icon      (Double-Click the Undo Icon)
Resets the Icon to the state of the Undo Icon at the upper right.    This item is disabled if the 
Edited Icon is identical to the Undo one.
The Undo Icon is updated each time you Change Tool; if you wish to update it while 
continuing to use a Tool, select another one, then reselect the one you need. You can see a 
blowup of this image at any time by clicking the Zm button or pressing Alt+Z.

Reload Original Icon
Reloads the original Icon from BMPTOICO's main form.    You will be asked to Proceed or 
not.    When the Image is reloaded, the Editor will be reset to its opening state.

Add Text
Allows you to add one line of text at a time, in the Arial font.    When you select this item, the 
Text function appears at the right: Enter Text in the white box, then play... Change the Size 
or Properties of the text, Move it inside the Icon with the four Arrow keys, Change its color by
picking a color from the color Palette.    If you want to start over, Click the Clr button.    When 
you are finished, Click the OK button: you will still be able to reverse the operation by 
Selecting Undo Last / Redo Last in this menu.
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BMPTOICO's Shareware version is not crippled in any way, except for the nagging screen upon 
opening and closing it.    I prefer you to have the full package, and decide if you wish to register 
or not. Also, being mostly house bound due to illness, I try to avoid trips to the Post Office to 
mail a complete version...    BUT:    After the 30 days trial period is over, you will have two more 
weeks to evaluate it, during which you might see reminder messages while the program is 
running. Then BMPTOICO will stop running, but will still show the nagging screen so you can 
enter the registration number if you got one.

Registration price is only $20 US ($20 Cdn if you live in Canada and pay by cheque or money 
order).    To register online on CompuServe, Go SWREG and select item #11559.

Please make all cheques, money orders or bank drafts payable to Lucie Dorais, not to MyCat 
Software.

Please send any correspondance to:
Lucie Dorais
603 - 222 Guigues
Ottawa, Ont.
K1N 5J2
Canada

Compuserve:  76440,623
E-mail:      l.dorais@genie.com

76440.623@compuserve.com
ldorais@cyberus.ca

Web:            http://www.cyberus.ca/ldorais/index.htm

Upon Registration:
You will receive a unique Registration number, which can be entered in the nagging screen 
(Click the Register NOW button), or at any time later by selecting Register in the Help 
menu.

Special Thanks to...
· Michael Coker, of Oxford, UK, and Joe Dacy II, of Burleson,Texas,    for their generous help 

with Windows 95, High Colors video mode, for beta testing version 2.0, and for making 
excellent suggestions.

· The pictures used in the Shrink examples were contributed by Paul Cohen, of England (tasty
beer mug), and my sister Jacinthe.






